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About this Manual/Getting Started 
The purpose of this manual is to aid users in setting up and performing maintenance of the 

Aquaponic Sensor Control and Monitoring System, also known as Sprout. This manual will help 

a beginner effectively use and maintain Sprout to keep their aquaponics greenhouse running. 

Sprout is used to monitor the delicate closed-loop ecosystem required for an aquaponic 

greenhouse. The manual includes a general description of the Sprout sensor system, including a 

parts description and an overview of the Graphical User Interface (GUI). Then, the manual will 

include instructions on setting up Sprout and replacing and calibrating the sensors. At the end, 

the manual will include links to the sources of the sensors, additional resources required for 

some procedures, a glossary, and an index.  

This section of the manual includes an overview of the contents of the manual followed by a list 

of conventions found in the manual. 

 

Overview of the Manual 

The manual contains three chapters and an additional section for reference material: 

Chapter 1: About Sprout  

In this chapter, you will find information on the components of Sprout. This chapter will first 

cover the hardware, and then it will cover the software. 

Chapter 2: Setting Up Sprout  

In this chapter, you will find information on how to set up Sprout. You will learn how to set up 

the hardware and the software, and how to perform simple sensor maintenance. 

Chapter 3: Calibrating the Sensors  

In this chapter, you will find information on how to calibrate the Electrical Conductivity sensor 

and the pH sensor. 

Reference Material  

In this chapter, you will find information on the sensors, additional resources required for some 

of the procedures, the glossary, and the index. 



 

Document Conventions 

Several icons will appear throughout the procedures in this manual. Be aware of their presence 

and refer to the following for their meanings:  

 

 

 

 

 

Chapter 1 - About Sprout 
This chapter will detail the physical components of Sprout and explain the GUI elements you 

will use to calibrate the system for your preferences. By the end of this chapter, you will 



 

understand how each component of the system contributes to the monitoring of your aquaponic 

greenhouse and how you can use it to better automate the process. 

In this chapter, you can find the: 

● Sprout Components 

● Overview of the GUI 

 

Sprout Components 

This section will describe the hardware components of the Sprout sensor system. Sprout 

includes several pieces of hardware held within the sensor bar housing, such as the six sensors, 

the Raspberry Pi 4, and the printed circuit board.  

 

Sensor Bar Housing 

The sensor bar housing is a two-chambered wooden structure that attaches to the side of the 

tank with a clamp. The structure is waterproof, with one chamber holding the electronics and 

keeping them safe from potential damage. The other chamber has holes in the bottom for the 

sensors to poke through so the sensor tips can take readings without being damaged. 

Figure 1 - Sensor bar housing set up next to monitor. 

The sensor bar housing provides a stable home for the six sensors for when they are regulating 

the aquarium. It is adaptable and can be attached to different sizes of tanks.  

 



 

Sensors 

There are six sensors in the Sprout system, with each sensor sending one reading to the 

computer. However, the Oxygen-Reduction-Potential sensor sends one additional reading to the 

computer for a total of two.  

The chart below names each sensor, explains what each sensor measures, and explains the 

purpose of each sensor. 

Table 1 - Names of sensors, a description of the sensors, and what they are used for. 

 

 

Part Description Purpose 

Dissolved Oxygen 

Sensor 

Measures the dissolved 

oxygen content in water.  

Low oxygen content in water can create 

harsh living conditions for aquatic 

organisms. 

Turbidity Sensor Measures the turbidity, or 

opacity, of water.  

The turbidity of water is directly 

correlated with bacteria content and the 

overall water quality. 

pH Sensor Measures the acidity or 

alkalinity of water.  

If the water is too acidic or alkaline, the 

plants may be unable to absorb certain 

nutrients. 



 

 

 

 

 

 

 

Part Description Purpose 

Oxygen Reduction Potential 

Sensor 

Measures the ability of 

oxidation and reduction of 

water.  

Measures the temperature of 

the water. 

Oxidation and Reduction 

indicate oxygen levels and 

quality of the nutrients 

within. 

Ecosystem of the greenhouse 

requires a stable temperature 

to maintain plant health. 

Conductivity Sensor Measures the ability to pass a 

current through water.  

 

The conductivity of water 

indicates the concentration of 

ions in the water and the 

salinity of the water. 

Ultrasonic Distance Sensor Measures the time lapses 

between the sending and 

retrieving of an ultrasonic 

pulse to determine the 

distance to a target. 

Maintains a consistent depth 

to the water to prevent 

overflow of the tank or 

damage to Sprout. 



 

Raspberry Pi 4 

The Raspberry Pi4 is a miniature computer. In the Sprout system, the Raspberry Pi 4 makes the 

calculations that process the sensor outputs and runs the graphical user interface (GUI).  

Figure 2 - Raspberry Pi 4. 

 

Printed Circuit Board 

The printed circuit board was made specifically for the Sprout system. It functions as the 

medium between the sensors and the Raspberry Pi 4. It processes the analog signal from the 

sensors and converts this information to a digital signal, one that can be read by the Raspberry 

Pi 4. 

Figure 3 - Printed Circuit Board (close up). 

 



 

Overview of the GUI 

This is the user interface for Sprout. It is the point of control and monitoring for users operating 

the sensor system. The GUI for the present iteration of Sprout is run through the compiler 

within the application Geany.  

 

Figure 4 - Mockup of Sprout Sensor GUI. 

A. The current levels column displays the current levels as detected by each sensor. 

B. The units column displays the units used by each sensor, such as Degrees Celcius.  

C. The status column displays whether the levels are in range, whether the levels are out of 

range, or if the sensor is experiencing a malfunction. 

D. The alarm settings column allows the user to select a lower bound and an upper bound 

for monitoring the levels of each sensor.  

E. The alarm log displays each recent alert. Each row includes which sensor sent the alert, 

what detected value caused the alert, and the time the alert was posted. 

 

 



 

 

Chapter 2: Setting Up Sprout 
Sprout is built to be a convenient, quick way to set up a monitoring system for your aquaponic 

greenhouse. The system has a quick setup. You can attach the sensor housing to your aquarium, 

plug in the monitor, set the alarms, and the system will run for you on its own. In addition, 

cleaning and basic maintenance of Sprout is built to be simple and intuitive.  

In this chapter, you will learn important steps to set up, take down, and perform simple 

maintenance on Sprout. You will learn how to set up Sprout’s hardware, set up Sprout’s GUI, 

and replace and clean the sensors.  

In this section, you will find information on: 

● Setting Up the Hardware 

● Setting Up the GUI 

● Replacing and Cleaning the Sensors 

Setting Up the Hardware 

This section of the manual will concern the basics of setting up Sprout’s hardware. You will learn 

how to attach the sensor bar housing to the Aquarium tank so that the system can function 

properly. The following instructions will also instruct you how to detach the sensor bar housing 

from the Aquarium Tank so that you can either store Sprout for later use, or manage cleaning, 

replacing, and calibrating the sensors. 

In this section, you will find instructions on how: 

● To Attach Sprout to the Aquarium Tank 

● To Remove Sprout from the Aquarium Tank 

 

 

 



 

To Attach Sprout to the Aquarium Tank 

1. Carefully lift the sensor bar housing over the tank so that the wooden casing is over the 

inside of the tank. 

2. Use your thumbs to press down the red handles to open the clamp. 

3. Lower the sensor bar housing so it is inside the tank and horizontal in respect to the 

floor. 

4. Release the clamps slowly. 

5. Remove hands slowly to ensure the sensor bar housing is securely attached to the tank. 

 

To Remove Sprout from the Aquarium Tank 

1. Securely place both hands on either side of sensor bar housing with thumbs on the red 

handles. 

2. Ensure that your grip is stable, then use your thumbs to slowly press down on the 

handles. 

3. Lift the sensor bar housing off of the tank. 

4. Put the sensor bar housing down, making sure to mind the probes sticking out of the 

bottom of the case. Place the sensor bar housing down so the probes and electronics do 

not get damaged or jostled. 

5. Wipe down the casing of the sensor bar housing with a damp cloth. 

6. Follow the steps to clean and store the probes, then leave the sensor bar housing to dry. 

 

 



 

Setting Up the GUI 

This section of the manual will cover the process for setting up the GUI, from connecting the 

monitor to setting the alarms. The computer setup for the Raspberry Pi is meant to be simple 

and easily customizable. If you need to move your aquaponic greenhouse, and likewise Sprout, 

you can quickly take apart the computer system to relocate. Running the GUI is simple as well. A 

user can easily execute the GUI file and set the alarm ranges using the interface. 

In this topic, you will find instructions on how: 

● To Connect the Raspberry Pi to a Monitor 

● To Run the Sprout GUI Through Geany 

● To Set the Alarms Using the Sprout GUI 

 

To Connect the Raspberry Pi to a Monitor 

1. Plug the monitor into a wall socket or extension cable port. 

Figure 5 - Micro-HDMI and USB-A ports on the Raspberry Pi. 

2. Plug the micro-HDMI end of the micro-HDMI to HDMI cord into the Raspberry Pi. 

 

 



 

3. Plug the HDMI end of the micro-HDMI to HDMI cord into the monitor. 

4. Plug your mouse into a USB port on the Raspberry Pi using a USB-A cable or bluetooth 

dongle. 

5. Plug your keyboard into a USB port on the Raspberry Pi using a USB-A cable or 

bluetooth dongle. 

6. Turn on the monitor. The Raspberry Pi Operating System (OS) should be up and running 

on your monitor. 

 

To Run the Sprout GUI Through Geany 

1. Make sure you have the Raspberry Pi 4 OS open and working on your monitor. 

2. In the top left of the screen, open the File Manager. The icon will be in the shape of a 

file folder. Upon opening, a new window will appear on your screen. 

Figure 6 - Location of the File Manager icon on the Raspberry Pi OS. 

 

 



 

3. From the ribbon on the left side of the File Manager, open the Documents folder. 

Figure 7 - File Manager application. 

4. Find the file named SproutGUI.py and open it using the Geany application. 

5. In the toolbar at the top of the Geany application, select Build then Execute. You will 

see the Sprout GUI open on your screen. 

Figure 8 - Location of the Execute function in Geany. 

 

 



 

 

You can also execute the file by pressing F5 on your keyboard, or by selecting the paper 

airplane icon in the toolbar. 

 

To Set the Alarms Using the Sprout GUI 

1. Make sure that you have successfully opened the Sprout GUI on your monitor. 

2. On the screen, find the row that corresponds to the sensor you wish to reset the alarms 

for. 

Figure 9 - Alarm setting tool in the Sprout GUI. 

3. In the left text box, input the number for the lower bound. 

4. To the left of the text box, select Set. 

5. In the right text box, input the number for the upper bound.  

6. To the left of the text box, select Set. 

 

Replacing and Cleaning the Sensors 

This section of the manual will cover how to perform simple maintenance on the Sprout System. 

Replacing the sensors is necessary to learn because they may require cleaning and need to be 

replaced after a certain amount of time. The Dissolved Oxygen and pH sensors require specific 

maintenance that will also be covered in this section. Both require different liquids to be stored 

within their caps to keep them operating at optimal capacity.  

 

 



 

In this section, you will find instructions on how:  

● To Replace a Sensor 

● To Replace the Dissolved Oxygen Sensor’s Filling Solution 

● To Clean the Sensors 

● To Clean the pH Sensor 

 

To Replace a Sensor 

1. Remove the sensor bar housing from the aquarium tank, ensuring the housing is in a 

dry, stable location. 

2. Carefully reach into the sensor bar housing and gently pull the probe out of its 

designated slot. 

 

Make sure to remember which sensor fits in which slot so you can return them later 

without accidental damages. 

 

3. Unplug the old sensor from the board. 

4. Take the new sensor and plug the end of the attached cord into the cable connector port 

on the board.  

If installing the Dissolved Oxygen Sensor, make sure you have filled the membrane cap 

with the Sodium Hydroxide solution before placing it in the sensor bar housing to be 

used. 

 

5. With the new sensor attached, slide the probe back into the sensor bar housing and fit it 

into its designated slot. 

 



 

To Replace the Dissolved Oxygen (DO) Sensor’s Filling Solution 

Sodium Hydroxide (NaOH) is irritating and corrosive. Wear gloves to keep NaOH 

Solution off of your bare skin. Do not touch eyes, mouth or nose. 

 

1. Turn the membrane cap clockwise to unscrew the cap. 

 

Make sure you fill the cap with the correct amount of solution. If there is too little 

solution, bubbles may form. Some solution overflow is acceptable. 

 

2. Make sure the cap is in a vertical position, then fill the cap ⅔ of the way full with 0.5 

mol/L NaOH solution. 

 

 Information on acquiring NaOH solution can be found in the References chapter. 

 

Keep the cap and the probe in a vertical position to prevent bubbles from forming in the 

filling solution. 

 

3. Make sure the cap and probe are in a vertical position, then carefully screw the cap back 

on the probe by turning it in a counter-clockwise motion. 

4. If some overflow occurs, carefully clean the excess solution with a tissue. 

5. Follow the instructions in the previous topic To Replace a Sensor to return the DO 

Sensor to the sensor bar housing. 

 

 

 



 

 

Figure 10 - Diagram of the process for filling the DO sensor’s cap. 

 

To Clean the Sensors 

1. Remove the sensor from the sensor bar housing. 

 

Ensure that you avoid getting the wire end of the sensor wet, for this may damage the 

sensor. 

 

2. Gently pour distilled water over the probe end of the sensor to wash off any residue. 

3. Gently dry the sensor with a soft towel, such as a tissue or a microfiber cloth. 

4. Return the sensor to the sensor bar housing. 

 

 

 

 



 

To Clean the pH Sensor 

1. Remove the sensor from the sensor bar housing. 

 

Ensure that you avoid getting the wire end of the sensor wet, for this may damage the 

sensor. 

 

2. Gently pour distilled water over the probe end of the sensor to wash off any residue. 

Figure 11 - pH sensor with cap. 

3. Unscrew the cap at the end of the sensor probe. 

4. Fill the cap with 1 cm of distilled water. 

5. Screw the cap back on the sensor probe. 

6. Gently dry the sensor with a soft towel, such as a tissue or a microfiber cloth. 

7. Return the sensor to the sensor bar housing. 

 

 

 

 

 

 



 

 

Chapter 3: Calibrating the Sensors 
In this chapter, you will learn how to calibrate the Electrical Conductivity sensor and the pH 

sensor. Regular calibration is necessary for these two sensors to ensure they maintain accurate 

readings. Reading this chapter will help you understand the importance of calibration to 

maintain the integrity of the monitoring system. 

In this chapter, you will need additional resources not found within the Sprout system. Please 

refer to Additional Resources Required for Procedures in the References chapter for more 

information. 

In this section, you will find information on: 

● Calibrating the Electrical Conductivity Sensor 

● Calibrating the pH Sensor 

 

Calibrating the Electrical Conductivity Sensor 

This section of the manual will cover the process for calibrating the Electrical Conductivity 

sensor. Calibrating the sensors does not require extensive knowledge of Aruduino or Python. 

These instructions are designed to guide an unfamiliar user through this technical task. 

Calibrating the Electrical Conductivity sensor regularly will ensure that the sensor is operating 

at optimal capacity.  

In this section, you will find instructions on how: 

● To Download the Zip Library for the Electrical Conductivity Sensor 

● To Add the Calibration Code to the Arduino Program 

● To Calibrate the Electrical Conductivity Sensor 

● To Add the Voltage Measurement Code to the Arduino Program 

● To Find the Voltage of the Electrical Conductivity Sensor 

 

 

 



 

 

 

 

 

 

 

 

 

 

Figure 12 - Electrical Conductivity Sensor. 

 

To Download the Zip Library for the Electrical Conductivity Sensor 

1. Open the GitHub Repository for the DFRobot_EC Library in your browser. 

2. Select the green dropdown menu labelled Code. 

3. Select Download as ZIP. 

4. Open the Arduino program. 

5. In the top bar, select Sketch > Include Library > Add .ZIP Library… 

Figure 13 - Add .ZIP Library in dropdown menu. 



 

6. Locate the DFRobot_EC Library you installed onto your computer and open it. 

 

To Add the Electrical Conductivity Calibration Code to the Arduino Program 

1. Open the Arduino program. 

2. Copy the Calibration for Higher Accuracy code found at the documentation site for 

the Electrical Conductivity Sensor. 

3. Delete all text in the Arduino program. 

4. Paste the code into the Arduino program. 

5. In the top bar, select Sketch > Include Library and select the DFRobot_EC Library. 

6. Save the file. 

 

To Calibrate the Electrical Conductivity Sensor 

1. Rinse the probe in distilled water. 

2. Dry the probe gently with a tissue. 

3. Submerge the end of the probe in the 1413 us/cm electrical conductivity standard 

solution. 

4. Shake the probe slightly to remove air bubbles. 

 

If the monitor prints a randomized sequence of symbols, you will have to change the 

baud rate at the bottom of the Serial Monitor screen. The baud rate of this program 

should be set to 115200. 

 

5. In the Arduino program at the top right of the screen, select the icon shaped like an 

hourglass to open the Serial Monitor. 



 

6. Input C calibration solution electrical conductivity in the Serial Monitor and 

press enter to calibrate the probe. 

7. The Serial Monitor will print the calibration value K. Record this number to be used in 

the following procedure. 

 

The calibration value K should be close to 1.0. 

 

To Add the Voltage Measurement Code to the Arduino Program 

1. Select File > New in the top bar to open a new file. 

2. Copy The First Measurement code found at the documentation site for the Electrical 

Conductivity Sensor. 

3. Delete all text in the Arduino program. 

4. Paste the code into the Arduino program. 

5. On line 14, at ec.setCalibration(1); replace the 1 with the calibrated K value. 

6. Save the file. 

 

To Find the Voltage of the Electrical Conductivity Sensor 

1. In the Arduino program at the top right of the screen, select the icon shaped like an 

hourglass to open the Serial Monitor. 

2. Record the detected voltage and conductivity, for the information will not be stored if 

you seek to access it later. 

 

 



 

Calibrating the pH Sensor 

This section of the manual will cover the process for calibrating the pH sensor. This process will 

have to be done twice for two different buffer solutions: one with a pH of 4 and one with a pH of 

7. Calibrating the sensors does not require extensive knowledge of Aruduino or Python. These 

instructions are designed to guide an unfamiliar user through this technical task. Calibrating the 

pH sensor once every 1-2 months will ensure that the sensor is operating at optimal capacity.  

In this section, you will find instructions on how: 

● To Download the Zip Library for the pH Sensor 

● To Add the pH Calibration Code to the Arduino Program 

● To Prepare the pH Sensor for Calibration 

● To Calibrate the pH Sensor 

Figure 14 - pH Sensor. 

 

To Download the Zip Library for the pH Sensor 

1. Open the GitHub Repository for the DFRobot_PH Library in your browser. 

2. Select the green dropdown menu labelled Code. 

3. Select Download as ZIP. 

4. Open the Arduino program. 



 

5. In the top bar, select Sketch > Include Library > Add .ZIP Library… 

Figure 15 - Add .ZIP Library in dropdown menu. 

6. Locate the DFRobot_PH Library you installed onto your computer and open it. 

 

To Add the pH Calibration Code to the Arduino Program 

1. Open the Arduino program. 

2. Copy the Example Code found at the documentation site for the pH Sensor. 

3. Delete all text in the Arduino program. 

4. Paste the code into the Arduino program. 

5. In the top bar, select Sketch > Include Library and select the DFRobot_PH Library. 

6. Save the file. 

 

To Prepare the pH sensor for Calibration 

1. Rinse the pH sensor in distilled water. 

2. Dry the sensor gently with a tissue. 

3. Submerge probe end of the pH sensor into one of the buffer solutions and stir gently. 



 

 

To Calibrate the pH Sensor 

1. Ensure that the pH sensor is properly prepared and submerged in the appropriate buffer 

solution.  

2. In the Arduino program at the top right of the screen, select the icon shaped like an 

hourglass to open the Serial Monitor. 

 

If the monitor prints a randomized sequence of symbols, you will have to change the 

baud rate at the bottom of the Serial Monitor screen. The baud rate of this program 

should be set to 115200. 

 

3. Enter enterph into the serial monitor. The program will enter calibration mode. 

Figure 16 - Serial monitor in calibration mode. 

4. Input calph into the serial monitor. The program will start calibration. The program will 

detect which of the standard buffer solutions you are using to calibrate. 



 

5. Input exitph into the serial monitor. The program will exit calibration mode. The data 

will then be saved to the EEPROM of the control board if you seek to access it later. 

6. If you have only calibrated using one of your solutions, repeat the steps once more with 

the other solution. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Reference Information  
This section of the user manual provides you with additional information that may be of use to 

you when reading this user manual. The sensor specifications section will provide you with the 

name of the sensor and a link to the wiki for that sensor. The Additional Resources Required for 

Procedures section will provide you with information on resources you may need to purchase to 

complete some of the procedures. The Glossary will provide you with definitions for some of the 

terms in this manual. Finally, the index will provide you with terms and their page numbers so 

you can find information quickly.  

 

Sensor Specifications 

The following table includes the name and source for each sensor used in the Sprout System. If 

you have any further questions about the sensors that are not answered in this manual, follow 

the link to the DFRobot wiki.  

Table 2: Sensors and where to find more information about them online. 

Item Source 

Gravity: Analog Dissolved Oxygen Sensor 

Meter Kit for Arduino 

DFRobot 

(https://wiki.dfrobot.com/Gravity__Analog_

Dissolved_Oxygen_Sensor_SKU_SEN0237) 

Gravity: Analog Turbidity Sensor for Arduino DFRobot 

(https://wiki.dfrobot.com/Turbidity_sensor_

SKU__SEN0189) 

Gravity: 7/24 Industrial Analog pH Meter Kit DFRobot 

(https://wiki.dfrobot.com/Gravity__Analog_

pH_Sensor_Meter_Kit_V2_SKU_SEN0161-

V2) 

https://wiki.dfrobot.com/Gravity__Analog_Dissolved_Oxygen_Sensor_SKU_SEN0237
https://wiki.dfrobot.com/Gravity__Analog_Dissolved_Oxygen_Sensor_SKU_SEN0237
https://wiki.dfrobot.com/Turbidity_sensor_SKU__SEN0189
https://wiki.dfrobot.com/Turbidity_sensor_SKU__SEN0189
https://wiki.dfrobot.com/Gravity__Analog_pH_Sensor_Meter_Kit_V2_SKU_SEN0161-V2
https://wiki.dfrobot.com/Gravity__Analog_pH_Sensor_Meter_Kit_V2_SKU_SEN0161-V2
https://wiki.dfrobot.com/Gravity__Analog_pH_Sensor_Meter_Kit_V2_SKU_SEN0161-V2


 

Item Source 

Gravity: Arduino Analog Industrial ORP 

Sensor Meter Pro for Arduino 

DFRobot 

(https://wiki.dfrobot.com/Gravity_Analog_O

RP_Sensor_PRO_SKU_SEN0464) 

Gravity: Industrial Analog EC / Electrical 

Conductivity Meter Kit for Water Quality 

Monitoring (K-1, IP68) 

DFRobot 

(https://wiki.dfrobot.com/SKU_SEN0451_G

ravity_Analog_Electrical_Conductivity_Sens

or_PRO_K_1) 

A02YYUW Waterproof Ultrasonic Distance 

Sensor (3~450cm, UART, IP67) 

DFRobot 

(https://wiki.dfrobot.com/_A02YYUW_Wate

rproof_Ultrasonic_Sensor_SKU_SEN0311) 

 

 

Additional Resources Required for Procedures 

Some procedures require resources not found within the Sprout Sensor system. The following 

section will provide information on which resources are needed to acquire for these procedures. 

The procedures and topics referred to in this section are: 

● Requirements for: To Connect the Raspberry Pi to a Monitor 

● Requirements for: To Replace the Dissolved Oxygen (DO) Sensor’s Filling Solution 

● Requirements for: Calibrating the Electrical Conductivity Sensor 

● Requirements for: Calibrating the pH Sensor 

 

 

 

https://wiki.dfrobot.com/Gravity_Analog_ORP_Sensor_PRO_SKU_SEN0464
https://wiki.dfrobot.com/Gravity_Analog_ORP_Sensor_PRO_SKU_SEN0464
https://wiki.dfrobot.com/SKU_SEN0451_Gravity_Analog_Electrical_Conductivity_Sensor_PRO_K_1
https://wiki.dfrobot.com/SKU_SEN0451_Gravity_Analog_Electrical_Conductivity_Sensor_PRO_K_1
https://wiki.dfrobot.com/SKU_SEN0451_Gravity_Analog_Electrical_Conductivity_Sensor_PRO_K_1
https://wiki.dfrobot.com/_A02YYUW_Waterproof_Ultrasonic_Sensor_SKU_SEN0311
https://wiki.dfrobot.com/_A02YYUW_Waterproof_Ultrasonic_Sensor_SKU_SEN0311


 

Requirements for: To Connect the Raspberry Pi to a Monitor 

The Raspberry Pi 4 runs as a computer does. To operate the Raspberry Pi, and thus the Sprout 

GUI, you will require: 

● A computer monitor 

● A micro-HDMI to HDMI cable 

● A USB-A compatible keyboard 

● A USB-A compatible mouse 

Instructions on how to set up the Raspberry Pi 4 computer can be found under the procedure: 

To Connect the Raspberry Pi to a Monitor. 

 

Requirements for: To Replace the Dissolved Oxygen (DO) Sensor’s Filling Solution 

Sodium Hydroxide (NaOH) solution is used to fill the membrane cap of the Dissolved Oxygen 

sensor. You can purchase 0.5 mol/L NaOH solution online or create your own by diluting 

stronger NaOH solution. 

To make your own solution for the Dissolved Oxygen sensor, first purchase the following items: 

● Sodium Hydroxide (NaOH) solution  

● Glycerinum dilution drops 

To create a solution for the DO sensor, add one to two drops of Glycerinum to the NaOH 

solution for every 100 mL of NaOH solution. 

Figure 17 - Dissolved Oxygen sensor. 



 

Instructions on how to fill the membrane cap of the Dissolved Oxygen sensor can be found 

under the procedure: To Replace the Dissolved Oxygen (DO) Sensor’s Filling Solution. 

 

Requirements for: Calibrating the Electrical Conductivity Sensor 

Calibrating the Electrical Conductivity sensor is important to ensure that the sensor is sending 

accurate readings to the Sprout GUI. Calibration must be done via an Arduino board through 

the Arduino IDE. It is suggested that you calibrate the Electrical Conductivity sensor regularly, 

though the exact frequency is up to your own discretion. However, you must calibrate the sensor 

at least once a year or if the sensor is taking noticeably inaccurate readings.  

To calibrate the Electrical Conductivity Sensor, you will require:  

● An Arduino board, found at the following link: 

https://www.arduino.cc/en/hardware/ 

● The Arduino IDE, found at the following link: 

https://www.arduino.cc/en/software/ 

● The library for calibrating the Electrical Conductivity sensor,  found at the following link:  

https://github.com/cdjq/DFRobot_ECPRO 

Instructions on how to calibrate the Electrical Conductivity sensor can be found under the topic: 

Calibrating the Electrical Conductivity Sensor. 

 

Requirements for: Calibrating the pH Sensor 

Calibrating the pH sensor is important to ensure that the sensor is sending accurate readings to 

the Sprout GUI. Calibration must be done via an Arduino board through the Arduino IDE. It is 

suggested that you calibrate the pH sensor once every 1 to 2 months. You must also calibrate the 

sensor if the sensor is taking noticeably inaccurate readings.  

To calibrate the pH sensor, you will require:  

● An Arduino board, found at the following link: 

https://www.arduino.cc/en/hardware/ 

https://www.arduino.cc/en/hardware/
https://www.arduino.cc/en/software/
https://github.com/cdjq/DFRobot_ECPRO
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● The Arduino IDE, found at the following link: 

https://www.arduino.cc/en/software/ 

● The library for calibrating the pH sensor,  found at the following link:  

https://github.com/DFRobot/DFRobot_PH 

Instructions on how to calibrate the pH sensor can be found under the topic: Calibrating the pH 

Sensor. 

 

Glossary 

Arduino: Arduino is a simple open-source electronics program that can read sensors. 

Calibrate: Adjusting the settings to the sensors so that the sensors can measure properly. 

GitHub Repository: A location where one can keep their information such as codes, files and 

file revision history. 

Geany: A text editor that contains IDE (Integrated Development Environment) components 

GUI (Graphical User Interface):  A graphical user interface is an electronic interface that 

connects with graphical components such as icons, symbols, and menus. 

Monitor: A type of hardware that allows graphics that are produced by a computer to be 

displayed. 

Sensor: A Sensor is a tool used to measure changes to the environment and allows a physical 

occurrence to be converted to an analog voltage that can be read by humans. 

pH: Is a quantitative measurement of acidity  or basicity within water solution or other 

solutions that are liquid. 

Printed Circuit Board: A mechanical substructure that holds and connects parts of an 

electric circuit. 

 

https://www.arduino.cc/en/software/
https://github.com/DFRobot/DFRobot_PH
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